Introduction

In this experiment you will use a pH sensor connected to a computer to generate titration curves. You will investigate two types of acid-base titration systems: one involving the titration of a strong acid by a strong base, and the other involving the titration of a weak acid by a strong base. A plot of the pH vs. the volume of titrant (solution in the burette) added shows how the pH of a solution changes as an acid, or base, is added. While performing these titrations you will be able to view the titration curves on the screen of the computer, and you will print out these curves after all of the data has been collected. One objective of this lab is to examine features of a strong acid-strong base titration curve and a weak acid-strong base titration curve. You will also learn how to estimate the pKa and the Ka for a weak acid from its titration curve.

You will obtain titration curves for the following combinations of acids and bases (Exact concentrations will be labeled on the reagent bottles and should be written in your lab notebook):

1) hydrochloric acid, HCl(aq), with sodium hydroxide, NaOH(aq);
2) acetic acid, CH₃COOH(aq), with sodium hydroxide, NaOH(aq).

Equations and Explanations

In an acid-base neutralization reaction, an acid reacts with a base to produce a salt and water:

\[ \text{HA(aq)} + \text{MOH(aq)} \rightarrow \text{MA(aq)} + \text{H}_2\text{O(l)} \]  
Equation 1

Acid \hspace{1cm} Base \hspace{1cm} Salt

At the equivalence point for an acid-base neutralization reaction, the amount of base added is equal to the amount of acid initially present; thus, the acid has been completely neutralized. The point in a titration where the indicator changes color is called the endpoint. An indicator is selected so that the color change will occur as close to the equivalence point as possible. For a given acid-base titration, a suitable indicator changes color over a pH range that coincides with the portion of the curve near the equivalence point where the pH rises sharply.

When a weak acid solution is initially present, the following ionization reaction will occur:

\[ \text{HA(aq)} \rightleftharpoons \text{H}^+(aq) + \text{A}^-(aq) \]  
Equation 2

The equilibrium constant for the ionization of the acid, Ka, is:

\[ K_a = \frac{[\text{H}^+][\text{A}^-]}{[\text{HA}]} \]  
Equation 3

At the volume half-way to the equivalence point during the titration of a weak acid by a strong base, one-half of the weak acid, HA, has been converted to its conjugate base, A-. Thus, at this half-equivalence point, the concentration of the excess acid equals the concentration of the conjugate base formed, [HA] = [A-]. Equation 3 then simplifies to become:

\[ K_a = \frac{[\text{H}^+][\text{A}^-]}{[\text{HA}]} = [\text{H}^+] \]  
Equation 4

Equation 4 can be written in logarithmic form by taking the negative logs of both sides:

\[ \text{p}K_a = \text{pH} \hspace{1cm} \text{but only if} \hspace{1cm} [\text{HA}] = [\text{A}^-] \]  
Equation 5

The equivalence point occurs at the midpoint of the region where the pH rises rapidly. The pKₐ can be determined by estimating the pH at the volume point halfway to the equivalence point.
Figure 1a shows the distribution of data points that should be collected in order to generate good curves for the titrations. Figure 1b shows a typical titration curve for the titration of a weak acid by NaOH.

**Figure 1a. Distribution of drops to yield a Titration with smooth curves.**

**Figure 1b. Acid-Base Titration curve for WEAK monoprotic acid.**

To perform the experiment, a computer-interfaced pH sensor will be placed in the acid solution. You will use the computer to monitor pH as you titrate, and you will enter the corresponding values for the mL of NaOH added. You will need to generate enough data points to obtain a smooth curve. In some regions of the titration, the pH changes very slowly, and you can add larger increments of base at a time. Near the equivalence point, the pH changes very quickly, and you will need to add single drops of base at a time.

**Procedure:** This lab will be performed in two weeks. You will collect data for the HCl-NaOH titration the first week. You will collect data for the CH₃COOH-NaOH titration and work on post-lab calculations the second week.

**Caution:** Sodium hydroxide will attack your skin and is very effective at destroying the tissue of the eyeballs. Make sure you are wearing your goggles at all times and that you rinse off any sodium hydroxide immediately!

1. Obtain 15 mL each of HCl and CH₃COOH and 50 mL of NaOH in three separate beakers. Record the concentrations of each solution in your laboratory notebook and lab report!
2. Calculate the volume of base needed for both titrations and show your professor the answers. Note: you should assume that 10.00 mL of acid is present for each titration since that is the amount you pipet into the titration beaker.
3. Obtain a magnetic stir plate, and attach a buret clamp to the vertical bar on the stir plate. Clean and condition the 25 mL buret with base. Refer to handout “Conditioning Glassware” for this procedure.
4. Measure 50 mL of deionized water with a graduated cylinder and pour into a 250 mL beaker. Pipet 10.00 mL of the standardized HCl solution into the beaker and add 2-3 drops of phenolphthalein indicator. Place the beaker on the center of the magnetic stirrer, and adjust the position of the buret above the beaker.
5. Obtain and assemble the computer and LabPro system. Attach the pH sensor to the CH 1 outlet on the LabPro unit. **Allow some space between your titration equipment and the computer!**
6. Refer to the handout “Using and Calibrating a pH Probe” for techniques and calibration procedures.

7. To access the experiment file, double-click on the “Shortcut to GCC Chm Labpro” folder on the desktop. Open the “HCl titration curve” file. Check the set up on the screen. The vertical axis of the plot should have pH scaled from 0 to 14 pH units. The horizontal axis should have volume scaled from 0 to 15 mL. (If the screen does not look like this, make sure the pH sensor is connected to LabPro, and the LabPro unit is plugged into a power strip that is turned on, then close and reopen the experiment file.)

8. Clamp the pH sensor above the acid solution using a 3 finger clamp. Lower the pH sensor into the acid solution, and adjust its position towards the side of the beaker, so that the sensor does not come into contact with the stirring bar. Begin stirring at a medium rate.

*Note: Stirring too rapidly could create a vortex around the sensor and possibly affect your pH measurements.*

9. You will need to collect 30-40 data points for a good graph. This process goes faster if one person manipulates and reads the buret while another person operates the computer and enters volumes. *All students are responsible for recording the pH and volume readings in their lab notebooks during data collection. Record and enter the volume readings to the nearest 0.01 mL.*

10. **Before adding any NaOH**, click “Collect” and monitor the pH for 5-10 seconds. Once the pH reading has stabilized, click the “Keep” button (top right corner). An “Events with Entry” window opens. In the volume box, type “0” (for 0 mL). Click “OK”.

11. Add approximately 1 mL of base. When the pH stops rising, again click the “Keep” button. (The pH readings may fluctuate; unless you are near the equivalence point, you can click “Keep” about 20-30 secs after adding base.) In the volume box, enter the total volume of base delivered, to the nearest 0.01 mL, and click “OK”. You will continue adding NaOH solution in 1 mL increments, clicking “Keep” to store the pH and buret readings after each increment of base added.

12. When your volume of base is within 2 mL of your calculated equivalence point, the pH values will begin increasing more with less volume of base added. Add volumes of base in smaller increments – eventually adding dropwise – before and after the equivalence point. You want to generate more data points in this region and plot a good curve before and after the equivalence point (see Figure 1a). Click “Keep” to enter a new buret reading after each increment. You need to make sure you get good curves before and after the equivalence point (see Figure 1a).

13. You should wait longer for the pH to stabilize for readings close to the equivalence point. **Make sure you record the mL of base and the pH corresponding to the appearance of the first faint pink of phenolphthalein that lasts for at least one minute. Continue to add base and enter volume readings after the endpoint.**

14. **After the equivalence point, the pH values will change by smaller increments (about 2 mL after your calculated equivalence point).** You can gradually revert back to adding the larger 1 mL base increments, making sure to enter the volume after each addition. Continue adding 1 mL increments of base and enter the volume after each addition until you’ve added a total of 15 mL of base.

15. When you have finished collecting data, click the “Stop” button. **Have your instructor approve your graph before printing.**

16. To print copies of the HCl titration curve, go to the “File” menu, select “Print Graph”, enter your names in the footer box, and click “OK”. When the “Print” window opens, click on “Properties” (to the right of PS-149), and select the Layout tab at the top. Select the “Landscape” orientation.
17. To print copies of the data table, go to the “File” menu, select “Print Data Table”, and click “OK”. After you verify that the graphs and tables printed out correctly, go to the “File” menu and select “Exit”.

18. From the “GCC Chem LabPro” folder, double-click to open “Acetic Acid Titration curve”. Refill the buret with base and adjust the level of base so that is initially at or below 0.00 mL. Repeat steps 4 and 8-15 for a second titration using CH₃COOH instead of HCl. For the CH₃COOH(aq) titration, the pH may initially change by more than 0.3 units for the 1st two mL of base added, but should level out in the buffer region.

19. When you are done with the pH sensor, rinse it with deionized water and place it in the sensor storage container.

20. **Have your instructor approve your graph again before printing.** Print copies of the Acetic Acid titration curve in the **landscape orientation** using the instructions from step 16.

21. Print copies of the Acetic Acid data table referring to step 17.

22. After you verify that the graphs and tables printed out correctly for both titration curves, go to the “File” menu and select “Exit”. **Make sure to shut down computer.**

---

**Waste Disposal: Discard the neutralized titration solutions in the sink with plenty of water.**

---

**Group Formal Lab Report** – All sections of this report must be typed – except calculations for questions 5-8! The graphs you printed in lab should also be written on to show appropriate results.

1. **Purpose:** in complete sentences
2. All data from both titrations including all solution concentrations.
3. Both graphs appropriately marked (see Figure 1b on page 2). You must write on these graphs!
   - HCl: **Mark the equivalence point, eq. pt. volume, and eq. pt. pH.**
   - CH₃COOH: **Mark the equivalence point, equivalence point volume, and equivalence point pH. Also mark the half-equivalence point, its corresponding volume in mL and estimated pH/pKₐ value.**

   i. The equivalence point occurs at the exact middle of the region where the pH rises sharply. Chances are there is no data point exactly at the equivalence point so it must be found graphically. Using a ruler and a pencil draw straight lines at the top and bottom of the titration curve (dotted lines) as shown in Figure 1. The equivalence point occurs at the middle of the vertical line between the top and bottom lines you drew. Measure the distance between the top and bottom lines (parallel to the y-axis, not your graph) then divide by 2 to find the exact middle of the vertical line – don’t eyeball it! Make sure the distance from your equivalence point to the bottom line equals the distance from the equivalence point to the top line. Refer to your graphs and data tables to estimate the volume and the pH at the equivalence point for both curves. **Mark the equivalence point, and write the corresponding pH numerical value and the actual volume in mL of the equivalence point on both of your curves.**

   ii. For the acetic acid plot, locate and **mark the half-equivalence point, and write the corresponding volume in mL and the estimated pKₐ value on the weak acid curve.** Refer to Figure 1 on page 2 for an example.

4. **Results** – Type the numerical values for the following in a summary table:
   - Volume of NaOH and pH at the equivalence point for the hydrochloric acid curve
   - Volume of NaOH and pH at the equivalence point for the acetic acid curve
   - Volume of NaOH at the 1/2 equivalence point and pKₐ for acetic acid curve
Questions (below): Make sure you answer the questions thoroughly enough that your instructor knows which question you are answering. Questions 1-4 and answers must be typed. Calculations (questions 5-8) may be neatly hand-written on in your lab notebook.

Conclusion (typed) – summarize the findings of the experiment. Remember to address the purpose of the experiment. State 3 possible sources of error AND discuss exactly how they affected your results.

Graded prelab notebook page for each member in the group.

Questions for Lab Report

1. A student obtained a wet buret from the cart but failed to rinse it with a small amount of the base before starting a titration. Will more or less titrant (base) be required to neutralize the acid? Explain your answer.

2. Compare the initial pH values for both titrations. Explain why the pH of the HCl(aq) solution is initially lower, higher, or approximately equal to the pH of the CH₃COOH(aq) solution.

3. What is the pH at the equivalence point for your HCl(aq)-NaOH(aq) titration curve? What is the pH at the equivalence point for your CH₃COOH(aq)-NaOH(aq) titration curve? For each titration, explain why the pH at the equivalence point is either acidic, basic, or neutral by indicating which substances are present in solution that result in the observed pH.

4. Compare the final pH for the HCl(aq) and CH₃COOH(aq) titration curves. Explain why this region is similar or different for the two acids.

5. a. Using the estimated pKₐ value from your acetic acid-sodium hydroxide curve, show your calculation of the experimental Kₐ value for acetic acid.

   b. Given the theoretical Kₐ value for CH₃COOH(aq) is $1.8 \times 10^{-5}$, calculate the absolute percentage difference between the experimental and theoretical values using the equation below:

   \[
   \text{Absolute % difference} = \left| \frac{\text{experimental } K_a - \text{theoretical } K_a}{\text{theoretical } K_a} \right| \times 100\%
   \]

6. Calculate the volume of 0.125 M NaOH needed to neutralize 25.00 mL of 0.100 M HCl. Include a balanced chemical equation in your answer.

7. Calculate the pH at each point for the titration of 25.00 mL of 0.100 M HCl with the following volumes of 0.125 M NaOH:

   a. 0.00 mL   b. 10.00 mL   c. 20.00 mL   d. 30.00 mL

8. Calculate the pH at each point for the titration of 25.00 mL of 0.100 M ascorbic acid (C₆H₈O₆) ($K_a = 8.0 \times 10^{-5}$) with the following volumes of 0.125 M NaOH:

   a. 0.00 mL   b. 10.00 mL   c. 20.00 mL   d. 30.00 mL